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Zedmed v36.8.1
Add all missing Cubiko database tables to list of tables Cubiko needs to access
) Two additional Zedmed database (SuperPlus) tables have been added to Cubiko accessible list of tables:
Office | ZED-9447 |1 pATIENT_FILE_NUMBERS
2. TAX_CODES
Zedmed v36.8.0

Fixes and enhancements

) An error occurred when trying to delete an attendance

Office ZED-9385 Fixed an issue preventing the deletion of an attendance if a bulk billing consent request has been sent.
Out-of-range error in the appointment grid

Office | ZED-9387 |Fixed anissue where moving forward in the appointment grid to a week that has an unavailable slot for a doctor
caused an out-of-range exception error to display.

Office/ Secure Send not working due to an incorrect URL

Clinical ZED-9388 The Secure Send production URL has been fixed.
The Referrals Expiring Report showed patients all expired referrals

Office ZED-9409 | The Referral Expiring report has been updated to suppress multiple entries for patients with more than one expired
referral for the same doctor. Now such patients will appear once along with the most recently expired referral date.

Zedmed v36.7.0

NEW Electronic bulk bill consent

The doctor's billing screen has a Bulk Bill Consent button that sends an SMS consent request to the patient. The SMS links to a page
containing the encounter's services and cost. The patient can read the information and select Accept to consent to be bulk billed. This

consent is recorded and will show on the invoice screen as "Medicare consent received" when reception does the billing. To learn
more see the new Bulk billing consent guide.

Patient Hame Jones, Mr Hapay ovA Medicare Number 29508620412 Safety Net
DOB 04121964 HCC Pension Status None Encounter Duration (:00:26
Search for item by number or description Seledied Iltems.
L Pl = Level B Surgery Consultation
Recent ltems
Fe] Level B Surgery Consultation
TEST 5 o v
Consent Request Confirmation
|
A Medicare Bulk Billing Request will be sent to the patient using the mobils phone number snd date of birth
displayed below. The mobile number can be chonged here withaut affecting the patiert record.
Patient Name Janes, Mr Happy t
Mobile Mumber |0491 573 087
Date of Brth  [0a/121954
|
T T
Attendance Notes
|
7 tep v ox X cancel

NEW Marketing Messages

You can now use SMS to send informational and promotional messages to select groups of patients using our new Marketing
Messages feature. To learn more see the Marketing Messages guide.
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Marketing Messages
»* Patient Demographics

] Exclude Casual Patients

[ 4ge I ) O
] sex at Barth Male | Female
] Has Veteran Card Ves Ho

[ Has medicare cara Yes Mo

[ Has Health Care Card (= ey No

ATSI
None Selected

#* Appointment Criteria
Filter by Appointments

(®) Both Attended and Unattended () Attended Only O Unattended Only
Date from Date to Branches 11 selected)
| 10/05/2024 :| = | 10/05,/2024 :| = IB“"‘" 1 |
Appointment Types Dactors (13 selected)
|one selected | rthur, Lesley, Boykin, E|...
Resources
None selected
Report Columns
] patient Full Name [ sex at Birtn [] Mobile Phone
] Address [ age [] Home Phone
[] Appointment Date/Time [[] work Phone
1 of | messagels) queued for SMS... process completed.
Frint Screen Export View History | Send SMS

NEW Allow bookings from different OLA accounts to link the same patient record

Patients booked for OLA appointments with their own account can also have an appointment booked under a family member's OLA
account. E.g, a mother adds their child to their OLA account as a family member and books an appointment. That child can still create
their own OLA account and book an appointment and both appointments will use the same patient record.

NEW Cubiko

Zedmed has added support for the Cubiko practice intelligence service. There is a direct link for Cubiko customers to access the
Cubiko App on Zedmed's Management tab. A subscription to Cubiko is required to use this service. To learn more about this paid
service, visit the Cubiko website.

An Integration checkbox in Practice Details > Integrations enables the data intelligence integration for Cubiko subscribers.
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NEW Credit Card Payment Support for Online Appointments
Practices can enable Online Credit Card payments for specific practitioners and appointments. The Credit Card information is
requested when the patient makes the appointment and used for billing after the appointment.

UPDATE: Update Return to Work SA

The way Zedmed users access Return to Work SA Work Capacity Certificates (eWCC) has changed. Telstra Health still hosts RTWSA
but the access point is changing to HealthLink Smartforms, which Zedmed is already integrated with. To learn more, see the RTWSA
guide.

Fixes and enhancements
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The Surgical Procedures report will now always show the Patient's Fund details.
Office ZED-8993 | Thereport previously only listed the Patient's Insurance Fund details when there was a quotation attached to the
procedure.
Secure Send is now correctly working for payment receipts in Office.
Office | ZED-9134 |The 'Send to Patient' button was not working correctly for Receipts. This has been resolved and you can now Print,
Email and Secure Send payment receipts from Office.
RTW SA forms are now displayed in Clinical'sSummary Views.
Office ZED-9356 | RWSA Work Capacity Certificates are now submitted using HealthLink SmartForms and Zedmed has been updated
to save these forms in Summary Views > Documents.
. Fixed the error "AppointmentList is empty" that appeared when clicking Bill.
Office ZED-9352 This error occurred when clicking Bill in the Appointment Book without having an appointment slot selected.
Office & Intramail's subject field is no longer truncated to 40 characters.
Clinical ZED-9138 The intramail subject will now display the full 100 characters in both Office and Clinical.
) The correct message will now display when selecting Reply in Intramail.
Office & ZED-9194 | Fixed the issue which in some instances caused a different message from the one selected to be displayed when
Clinical replying or forwarding an intramail message.
Text selection is now supported for PDFs so you can Copy/Paste text in Clinical and Office .
Two additional toolbar buttons have been added to the viewer for PDF documents in Clinical and Office that switch
the mouse action between panning the document and selecting text. This allows text within the PDF to be easily
copied and pasted into other documents.
Result View Enhanced View
| save As [Eprint [ Print (with printer selection) | | Fitwidth 1 FitPage ) ZoomIn = Zoom Out
Office & his is a test PDR
. ZED-9247
Clinical
=
< 5 pd
_Besu\t Navigapon . ) Acdtions - B
B pumaeen|| o | nen | neinne | atmment| - faio | Conpie || hatiea | omsateResu P | Wfdme
The Problem/RFE window will now correctly update when switching tabs or reopening an encounter.
Clinical | ZED-7662 | When switching between problem tabs during a patient encounter, the incorrect information for the selected
problem was displayed.
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Clinical |ZED-8991

Blood O2 Saturation Values are now supported in Patient Observations.

The Patient Observations screen now enables the recording of Blood Oxygen Saturation measurements. The new
measurements are included in the General Measurement Reports and in the MergeFields in the Template Editor and
Letter Writer.

Date of Observations: |10/05/202¢4 7] Add Ancther Set of Obsenvations
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Clinical | ZED-9006

A securely sent Referral Letter will display a warning if you select Secure Send again in the same letter.
This is to avoid the same Referral Letter being accidentally sent to a patient more than once. This update does not
apply to Pathology or Radiology Referrals.

Clinical |ZED-9141

Zedmed has added the Vision Radiology template to Clinical.
This means you can now print referrals to Vision Radiology paper when writing a Radiology Referral. Selecting a
recipient laboratory from the Referrals module sets the template to be used.

Clinical |ZED-9193

The Clinical History User Group field now displays the assigned group when editing a staff member.
In Zedmed Security Roles and Users, there was an issue where Clinical user groups were blank when opening User
details.

OLA ZED-9201

Fixed a time-out issue that prevented Upcoming or Previous appointments from displaying.
This problem prevented appointments from appearing in the My Appointments area.

Utilities | ZED-9001

Fixed the error "Access Violation" when running Pattie.
This issue occurred when Zedmed wrote to the log files that caused the Pattie system to crash.

Zedmed v36.6

Upgrading to this version will provide the following updates.

IMPORTANT: This upgrade will update your eRx certificate and change the communication endpoint from HTTP to HTTPS.
This update is required because the erx.com.au :8830337559 certificate isexpiring on 25 June 2024 and the eRx Adapter must be
updated to ensure continued operation of the eRx service. HTTPS will use a different port and the eRx web address will change to
HTTPS. If you use a firewall with port/internet restrictions, you may need to open a new port to support the new endpoint.

NEW Referrals Expiring Report

This report allows the practice to see expiring referrals by Date, Practitioner and Appointment Type and send SMS notifications to
patients regarding their referrals. Learn more.

NEW Billed status in the Appointment Book
A $icon (see screenshot) will now appear in the Appointment Book next to patients who have been billed. The billed icon is part of the

following sequence of status icons: File Pulled > Attended > Billed.

I 45(5) 17 Jones, Marrianna-Louise

:

Shd Consultatiof
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NEW ATSI status in Clinical
The ATSI status in the patient's record is now reflected in Clinical with icons.

Jones, Ms Marrianna-Louise [Ef | Jenes, Ms Marrianna-Louise [E

OF i Of iy Clos

Caoble, Mr Bartholomew

Jones, Ms Marrianna-Louise

NEW Drugs Module without MIMS
Zedmed's Dugs module can now be used to create prescriptions without MIMS.

API

ZED-9284

Move Office interface endpoints from Hl service into Zedmed API for Jayex
Office interface endpoints have been migrated from the old Hl service into the Zedmed API for Jayex.

API

ZED-9230

Created Jayex rest APl endpoints in Zedmed API (This update applies to Jayex kiosk customers).
Jayex APl has been moved from HI Service into Zedmed API (by default the port number is 9821).

Inthe CRS_App_Server.iniis still required for the Jayex integration to work - please note that the config:
[OfficeHIService]

RunRestService=Yes

System

ZED-9336

Further enhancements to Zedmed's internal process logging
Added more targeted logging surrounding the clinical service hang issue. Made a change to MIMS
initialisation that may fix the hanging issue and changed the MIMS config use of database connections.

System

ZED-9294

Enhanced Zedmed's logging functionality

Improved the options available to log Zedmed's internal processes when troubleshooting problems. This
improved logging level can only be manually enabled and disabled by Zedmed on the practice installation
once the practice provides access. Changing logging levels requires a restart of the Zedmed service.

Office

ZED-9195

Add the eRx certificate updater to the Zedmed upgrader which changes the communication endpoint from HTTP
to HTTPS

This update is required because the erx.com.au :8830337559 certificate is expiring on 25 June 2024 and the eRx
Adapter must be updated to ensure continued operation of the eRx service. HTTPS will use a different port and the
eRx web address will change to HTTPS. If you use a firewall with port/internet restrictions, you may need to open a
new port to support the new endpoint.

Office

ZED-9256

Fixed performance issues and missing QR codes for printed electronic prescriptions
Replaced the application used for QR Code Generation to improve the performance and resolve a missing QR
code issue when printing paper prescriptions with eRX enabled.

Office

ZED-8859

Create a new report "Referrals Expiring Report"
A new report is available in Office to show patients with upcoming appointments for which their referral letter has
expired. The Referrals Expiring Report can be found in Management > Reports.

Office

ZED-8899

Add a Billed symbol to the appointments screen once a patient has paid/been billed
Zedmed Office now displays a billed icon on the appointment screen after a patient has been admitted and billed.

Office

ZED-8940

On Patient Details Other Contacts set default phone number to Mobile
Next of Kin and Emergency Contacts now default to Mobile Phone rather than Home Phone in Patient Details.

Office

ZED-8952

Dr Name merge field not working in SMS reminders when a title is not specified
Scheduled Appointment Confirmation, Reminder and Recall messages that include the Doctor Name merge field
now correctly include the Doctor's Name for a doctor who does not have a Title specified.
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Clinical

ZED-9343

Fixed an eScript Error that occured if a drug had an AMT-MPP code but no AMT-TPP code.
The drugs known to have this issue are: Gabapentin 100mg Oral Capsule 100mg [100] & Tamsulosin hydrochloride
400mcg Modified Release Tablet 400mcg [30].

Clinical

ZED-8836

Prevent failure to load HealthLink forms when one of the HL7 files cannot be loaded
Issue that caused failure while loading HealthLink Forms if an HL7 file is corrupted has been fixed. Now forms will be
loaded even if a corrupted file was detected. Corrupted files or data parts will be skipped.

Clinical

ZED-9128

Fixed an issue causing MHR upload failures
Fixed the issue that caused the MyHealth Record upload process to fail when marking jobs as ready to be sent.

Clinical

ZED-8870

Zedmed APl issue - An Invalid Connection String Argument
The issue that caused the “An Invalid connection string argument” error during the MIMS update check or when
prescribing electronically has been resolved.

Clinical

ZED-8872

Validate Email and mobile data entered into the Address book

Zedmed Clinical now validates the email and mobile phone fields when creating or editing a contact in address book.
The email entered must conform to "user@hostname" pattern, whereas mobile phones must be 10-digits long
(without spaces), or up to 12-digits long (with spaces) and begin with "04".

Clinical

ZED-8855

Disabling use of MIMS as a database does not allow to use Drugs Module

Added the ability to use the prescribing module in clinical without having MIMS installed. Un-check the "Use MIMS
for Medication Database" option in the Drugs tab of Global Options Note that only recipe drugs will be available to
prescribe.

Clinical

ZED-8894

Save column order not working in My Options
Zedmed Clinical medications dialog will now remember user-specified grid column order and widths on the "Existing
Drugs" tab page.

Clinical

ZED-8897

Add ATSI status to the patient demographics
A patient's ATSI status is now displayed graphically in the Patient Details screen within Clinical.

Clinical

ZED-8908

Change the pregnancy shortcut key from ctrl-B to something else that is available
The keyboard shortcut to open Encounter > Pregnancy module has changed from Ctrl-B to Ctrl-Alt-B.

Clinical

ZED-8910

Current/Resolved problems move arrow not enabled when moving to next item
Fixed issue that required an extra click away from the list to re-enable the arrow to move problems from Current to
Resolved or vice versa.

Clinical

ZED-8912

Uncheck authority if private is selected as PBS Status in Prescription Script details
When prescribing a Drug with a PBS Status that requires an Authority, if the status is changed to Private, the
Authority checkbox is now automatically cleared

Clinical

ZED-8944

Global options Max file upload size text box is incorrectly displayed on all tabs
A cosmetic issue has been fixed on Clinical global options dialog where the max file upload size edit field would
continue to display on all tab sheets.

Clinical

ZED-8953

Letter Writer - Insert > Today's Notes inserts the text with incorrect formatting
When "Todays Notes" are inserted from the Letter Writer in Clinical the notes no longer contain additional blank
lines.

Clinical

ZED-8980

Fix buttons displayed on allergies message box question
When changes to a patient allergy are about to be inadvertently lost, the confirmation message box now displays Yes
and No buttons rather than Yes and Ok buttons.

Zedmed v36.5

Upgrading to this version will provide the following features and updates.

To assist with the adoption of these new features, see theZedmed v36.5.2 checklist.

NEW Electronic signatures
Electronic signatures can now be added to letters and referrals by applying the 'signature image' merge field. Simply save the
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practitioner's signature as an image file and upload it to their profile. Learn more.

NEW Secure Send
Secure Send is a feature that uses email or ZedSMS to send invoices, documents and referrals (including radiology and pathology
referrals) to the patient or payer using a link to a secure download. Learn more. To enable Secure Send, submit a request form.

NEW Automatic recall reminders
SMS recall reminders can now be scheduled to go out automatically using the same process as scheduled appointment reminders in
Zedmed's SMS Configuration console. Learn more.

NEW MyMedicare support

MyMedicare is a voluntary patient incentive scheme designed to formalise the relationship between patients and their practitioners.
This update supports MyMedicare bulk billing incentive items, and the ability to record and display a patient's MyMedicare
registration status in Zedmed. Learn more.

Office

ZED-8766

Resolved Error: Cannot Reconcile Patient - Duplicate Message_ID
Fixed an error that could occur when performing a provisional patient merge. This error would occur when the
patient already exists in Zedmed and replies to an SMS before the patient reconciliation occured.

Office

ZED-8767

Resolved an Error that appeared when adding a patient to an appointment from the waiting list.
Fix an error that occurred when adding a patient to an appointment using the cancellation waiting list - if an
SMS reminder had already been sent for the existing appointment.

Office

ZED-7765

Resolved Error Code 400 when creating a Doctors App QR Code.
Fixed an error that could occur when creating a Doctors App QR code in Zedmed. The code is scanned by a
user to enable to app on their device.

Office

ZED-8794

New Medicare Plus Incentive items
A notification will advise if New Medicare Plus Incentive scheme items are available to the patient during

billing. This includes the new MyMedicare incentives.

The following billed items qualify for Medicare Plus Incentive items.
Click 'Add Items® to automatically add the ticked items to this invoice.

Incentive

ftems

' 10990(25/10/2023) 23 for service item of Group Al of Category 1

Items Description

onres

Clinical

ZED-8978

Fixed the Results Inbox sort order
The Results Inbox now sorts the results correctly when sorting by the Result Reported Date when you use Get
all Results for a Patient button. The Result Reported Date is the date of collection/testing

Clinical

ZED-8589

New Radiology referral template: iMed Radiology Imaging Specialist
The Radiology-MedReferralSpecialist request form is now available as a Radiology Form in Clinical.

Clinical

ZED-8881

New Radiology report template: iMED Radiology - Myocardial perfusion imaging request
The report template Radiologyl-MedMyocardialPerfusionlmaging is now available in Clinical.
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The red lines in Zedmed's modern Ul option can be changed to grey
Added the ability to change the red lines separating each section in the Clinical Ul to grey lines. This is changed
in Clinical Tools > My Options > General tab under Line Colour: Red/Grey.

Show |Last 10 Consultations » | I History View Use Chronic Disease Module
Clinical |ZED-8702 || Deaurrempisee e ] | F5, 7 Ono @ sie Detoun
Document Template |R:1 Letter - Standard P | Clear
. Y bon Timer Al
Themes Line Colour Consultation Timer Alert
O Classic (® Modern @ Red O Grey [Juse Consultation Alert | B2ep at End Time
Address Book L g5 -
OA}k Ewery Time @ Zedmed O HealthShare
? Help ok X cancel

Removed Measurements from the Clinical document writer's Details Merge fields
Clinical |ZED-8728 |Removed the outdated "Measurements" merge field from the Clinical document writer's template tools. The
"Measures" merge field should be used going forward.

AIR Update - New mandatory field: Vaccine Type (Regulatory compliance update)
Added a new field mandatory field called Vaccine Type that will be required for government compliance in

March 2024, and expanded the Route option descriptions.

Immunisation X
Doctor
Branch: Albany Road Clinic w [ Mot Given Here
Name:  Phillip Davis v Administered Overseas

Immunisation Details
Brand/Vaccine: l l] Manual.
incude non-AIR vaccinations
linical | ZED-8802
c a 8 Date Given: | 10/01/2024 =]
Dose: Schoal ID: Required only if immunisation
administered at a school

Batch Number: ~| [ store Batch No. (available from the ACARA
~

Australian Schools List)

Site: |
Route: [ ]intramusculas [ ] Subeutaneous [ ] Oral [ Intradermal
I Vaccine Type: [ ] Antenatal CINIP or Commonwealth [ ] Private || State Program ]
Comment: | |
Add Recall o oK X cancel
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Clinical |ZED-8781

Send directly to pharmacy option for electronic prescriptions (Regulatory compliance update)

On the Electronic Prescriptions screen, there is now a "Send directly to Pharmacy" checkbox with a reasons
drop-down. This option will print out a QR code (token) for the prescription that can be faxed or scanned then
emailed directly to the pharmacy. This is for compliance with state and territory legislation that prevents
prescriptions from being given to patients for specific controlled substances.

Flectronic Preseription

Dr Phalip Crawis RACGE | Mctes for pharmscist (staged suppdy, speaal approval, specdic condrtion, ete.
Branch © HOTE: may be visible Le palient,
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SOUTH MELBOURNE 3205

Fresiber Number: 3677773 Phane Number: 03 8264 3300
Fatient's Mame Ms Marrianna | oulse lones Fatient's Medicare ITBOIIETHY
Address 6 Janes Pl
GOWRIE 2804 Fhamaceutical eretits entalement Raute of Adminstration =]
number
Date of Birth  19/05/1967 FESSayNet  []  Concessianal or sepencant O | Clinical Ingication |
entitlement card RPES benehicary or PES Satety
Date /012024 holder et card halder
Minimim Repeat intersal [cays) |
FES [ APEs []  Eand substitutions nat permitted [
Warrant number
Rosuvastatin
smy Coated Tablet 5mg [30] [Clunusual Dase
PUFF
[ ] Senpt s tar urgent supply |seript awing)
Qty: 1730 5 repeats
Electronit Preseribing Taken delivery
O (06997730
CEmail |
(Mo Electronic Token
(I Print Paper Token
1B Unioad seript o Active Script List

[)5enc prescnption crect tc enarmacy  Reasam: | Desing Pt

The option sbave will prevent the patiend from receiving the token, It is intended that the paper Loken
36 piied and prouiced dreety tn fhe pharmacy.

This i due Lo 2 requirement in indwidual stale and teritory legisiation thal prevents prescrptions from
neing hanadrd aver to the patient for specic contralled substances.

7

[E Fresuribe Bectionically | Cancel
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Dosage information is now mandatory for all prescriptions (Regulatory compliance update)
Prescribing now requires dosage information in the Dosage Full Text field. This is a compliance update for
electronic prescribing that has been applied to all scripts.

(7] O
Atenolol 50mg Coated Tablet 50mg [30]
You selected: Atenalol S0mg Coated Tablet Tablets) SO0mg [30]
Dosage Frequency Instructions MIMS Reference Information
capsule atter meals | A The MIMS information displayed below is of product “Atenolol REX Tablets Smg (307", this
Half 2 diop as directed | = information may vary for other products/brands with the same generic name.
—— | puff as needed
1 2 || g || tapie at night ANt Dasne
| | Ztimes a day before meals Admin > 100 mg/day as divided dose. Hypertension: initially 50 mg/day; may incr by 50 mg/day every
i 3times a day in the marning wi to max 200 mg/day. Angina: initially 50 mg/day; may incr to 100 mg/day. Arrhythmia
4 5 | 6 | 4timesaday maintenanee: 50-100 mg/day. MI maintenance: 50 mg/day for 1-3 yrs. Initiate after early intervention
every & hours with other agents or immediately if patient presents > 12 hrs post-ML Renal impairment. CICr 15-35
] [ every 6 hours mL/min: 50 ma/day or 100 mg on altemnate days; CICr < 15 mL/min: 50 mg on alternate days or 100
7 8 | 9 | onceaday mg every 4th day; haemodialysis: S0 mQ after dialysis. Eldenty: consider dose reduction. Withdrawal:
L weekly reduce gradually over 8-14 days
Cir L] | 00
| Drua Use
e Error X lon, all grades incl renal origin; frequent disabling angina
Cakulator ¢ arrhythmia; MI {late intervention) (> 12 hrs after chest pain
Dosage for use) must be order
to preseribe. h

IEonge Full Text E

El

©Undo | | C4Redo | | Clear | |
(®) Regular Use (O PRN () short Tem
Quantity | 130 j Repeats x PES does not allow repeats
Script Date:  |19/12/2023 [ PBS Status
] Hide from display (srchive) if not curent  Medicine estimated to last untit [15012004 |18] et e e etianjiN
C I I nical ZED'8840 Eunmu script to Active Saript List Bwam me to renew script after IO?JUHZOM ﬂi |:| Reg2d Include Brand on Scaript
[ Autharity Brand Substitution MOT Parmitted
Drug Notes
|Add to encounter notes
MIMS P, MIMS CJAL | Yy Add Favourite  Addto History Iﬂ Prestribe a'emmnlul |  Prescribe i ' XQ«:!
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New Practitioner ID option as an alternative identifier for Online Appointments.
Zedmed can generate a Practitioner ID so a doctor can be set up for Online Appointments. This is ideal for
treating doctors without an HPI-I. The Practitioner ID is assigned in the doctor Details screen, along with the
Available Online setting for OLA.
Clinical Settings
ZED-8650 Qualification [M88S Lo Ll
OLA R Status _ —_—
ZED-B6d || eomare | P = ol il
Email Address 1
i ECLIPSE Fund Schemes [[Jshow Code on Appt. Screen
Online Appointment System Text for spedarl;r-malmenl
Practitioner I L i
[69201FAD- = Generate -
Signature Image
Find Cancel
Patients must now choose an appointment type in Online Appointments
Online Appointments no longer has a default appointment type. Patients must select an appointment type to
create a booking, ensuring they book for the intended appointment type. This prevents patients from booking
the incorrect appointment type and allows you to only give new patients a new patient appointment type.
OLA ZED-8654 %
What type of appointment are you
booking today?
[ Std Consultation l I Review Consultation I
N
Zedmed v36.3.4
Upgrading to this version will provide the following updates.
. Resolved Error: Item not found when closing a patient file in Zedmed Clinical.
Clinical | ZED-8867 | Thiserror occured when opening a patient in Clinical from Office, if Clinical had not been shut closed properly.
o Resolved Error: List Index (1) out of bounds.
Clinical | ZED-8886 | This error also occured when opening a patient in Clinical from Office, if Clinical had not been shut closed properly.
. Resolved Error: Unsatisfied constructor on type: MyHealthRecord.Conversion.TMhrDocumentView.
Clinical | ZED-8865 The error occurs when trying to view a result that has been added to the summary view from My Health Record.
Resolved Issue with Zedmed Upgrade file v36.3.3
Upgrader | ZED-8882 | The error prevented some users from upgrading.
Zedmed v36.3.3

NEW HealthShare integration

The Clinical Address Book is now integrated with HealthShare so practitioners have access to Australia's most used Specialist and
Allied Health directory for letters and referrals. This feature requires internet access. Learn more in our HealthShare guide.

NEW Intramail search

There is now a search option in Office and Clinical Intramail so you can search your inbox and sent items for mail using the sender's
name, subject, date range or a linked patient. Learn more in our Intramail guide.

NEW Editor for Office templates

For the most up-to-date documentation version, visit https://help.zedmed.com.au/help


https://www.healthsharedigital.com/solutions/referrals/
https://help.zedmed.com.au/help/healthshare
https://help.zedmed.com.au/help/intramail-system#intramail-search

For customers who do not have Microsoft Word, we have added a Zedmed RTF editor so you can create custom Office templates.
This is useful for on-premise customers moving to Zedmed Cloud. Learn more in our new Office templates guide.

NEW Banking Report enhancements

10 updates to Zedmed's banking reports to improve clarity and consistency.

Office

ZED-8409

Support has been removed for 3rd party SMS providers
Support for "SMS Everyone", "Inspirus" and "Other"(generic) SMS providers has been removed. ZedSMS
replaces these providers for the sending of SMS messages from Zedmed.

Office

ZED-8832

ZedSMS performance updated
The ZedSMS SendPoint was updated to improve the send and receive speed of SMS messages.

Office

ZED-8466

ZedSMS Purchase Link updated
Updated link to purchase credits for ZedSMS due to the change in supported providers. It now points to the
ZedSMS Message Centre.
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Office ZED-8418

Banking Report enhancements

The following enhancements have been made to Zedmed's Banking reports:

e Removed unused HealthPoint sections from bank reconciliation, deposit & session reports.
* Widened the payer name column On behalf of to accommodate longer names.
e Renamed the 'Bank Reconciliation Report' heading fromReversals to Cross-Session Reversals to

reflect the data presented more accurately.

Batches
Closed On Batch # Cash Cheques MC Chq Cards Total EFTPOS
23-Jun-2023 4 21330 0.00 270 10675 341335 4212.49 142 60
Totals 21330 000 270 10675 41335 4,212,483 142 60

HealthP oint

0.00

Totals 0.00
Direct Deposits
Date Paid by Bank Branch Details On behalf of Pay Date Amount
01dun2022  Medicare Reserve Canberra Dr Jackson Medicare 13245

e Updated the Bank list label to say, Show Inactive Bank Accounts (previously 'Show All Bank').
o New page on staff change checkbox is now only enabled if Group by staff member checkbox is ticked.

Banking Reports

Bank Deposit screen or the Print/Close Session screen.

Style
(®) Batch Details
Batch Number | <Current Batch>

OSession Dretails
Session Number | 34 Started On 15/03/2023 9:22:19 AM

OReconciIiation Report

From [o1/112023 A|F T [onuv22 2|F

Print Screen Export

Use this screen to print reports on previous and current batches and sessions. If you want to close a batch or session, please use the

To ensure this report includes all transactions from all other workstations, it is recommended you exit from all
instances of Zedmed Office running on this workstation and log in again.

Criteria
Banklist [Dshowlnacti\re BankAccount]
| Albert Road MC Bank Account v

D Group by staff member

Mew page on staff change

Test Branch 1 FDAVIS

e Fixed anissue where payments by staff would not print on separate pages if the option 'New page on

staff changed' was selected.

e Fixed anissue to prevent using the same reason text for all reversals made without closing the

payment enquiry form.
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Resolved an issue with the inclusion of cross-session reversals
The Banking Batch Details Report now takes into consideration any cross-session reversal transactions in
the overall totals section of the report.
Session Totals Overall Total 71.30
Cash 7130 Credi Card 000 Cheques 0.00
Direct Deposit 000 EFTPOS 000 Medicare Cheques 0.00
HeathPoint 000
Office ZED-8445
Banking Session# 2
Banking Session# 6
rCrou—t‘-‘;e“ion Reversals
2100712023 2 Black, Emma -7.30
L W rong pay ment in difierent ses
Report Totals Overall Total 71.30
Cash 7130 Credit Card 0.00 Cheques 0.00
Direct Deposit 0.00 EFTPOS 0.00 Medicare Cheques 0.00
. Changed the Banking Reconciliation Report date format
Office ZED-8463 . . .
The Banking Reconciliation report now consistently uses "dd/mm/yyyy" as the date format.
. Changed the date format for Reversals on banking reports
Office ZED-8500 . . . , .
Reversal transactions printed on banking reports now use "dd/mm/yyyy" as the date format.
Resolved an error encountered when canceling an invoice without a service record
This error occurred when creating an invoice, adding then removing a service and then trying to delete the
invoice. This error will no longer occur as the action buttons will be disabled when no service items are in the
service item list or in the add service item box.
Office  |ZED-8432 | | ciam () Fund (o
Error >
Services
Date Item= Description Save invoice(s) error!! Press 'Cancel' button on Invoice Form to lotes
|JJ_ " " cancel the invoice!
Resolved performance issues caused by an Hl service outage
This fix prevents the Patient records from loading very slowly during the opening of multiple patient records
when the Hl service is down. The IHI check should now be run in the background for each individual patient
Office ZED-8436 | without slowing down the Ul performance.
Additional information has been added to the MHR Status section of the patient record and will display
when the IHI check is running and if the check times out it will update to display this information.
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Resolved anissue that caused a Patient's name to be cut off on the Patient Letter pick list.
In the Patient Pick List Dialog (Patient>Letters>Pick List) - Last letter of Family name was cut off due to the
font style.
Office | ZED-8480 |[Pick List
l} Carter Devall
[ Title From To Created CreatedBy  Bm Location |
Fixed Error 'Midnights not a valid time,' on the Waiting Times report.
Fixed an issue where an error was displayed when Midnight was selected as the End Time on the Waiting
Times report. Occurred when you select Daily Reports > Waiting Times > Select the End Time dropdown and
choose Midnight > Click on Print or Screen.
Report Critena
(@) Detailed repart Eniry Dat= [eemeymzs EF (epamz &S| F
Group By  pipnd E1TeT cocumred > L
Order By M‘h 6 ‘Midnight’ is nat 2 valid time. —Vl
() Waitng tmes by E | Details > > | i i
Office ZED-8530 () Patient per hour B [] Send this error via Internet Copy ta Clipboard [] |
| Attach a Screenshot image |
Aoptjattend (at=r of) | ta | Admission time v
Resolved an issue that caused a patient's pronoun to disappear
Office ZED-8534 | Fixed anissue where clinic-defined pronouns (dropdown list management ) could disappear from the
pronouns selected for a patient.

For the most up-to-date documentation version, visit https://help.zedmed.com.au/help



Resolved a Booking Wait Time Report error and corrected the changes shown
The Booking Wait Time report will now display changes from the last edit made to an appointment.
Additionally, the report has been fixed to prevent an error when running the report for a single patient.

| Booking Wait Times x|
Start End
Endii % Period 12/09/2023 12:00:01 AM v~ 12/09/2023 11:53:59 PM v|
. Could not convert variant of type (UnicodeString) into type Branch  ALL vl
Office  |ZED-8594 || €@ St
Staff ALL v
oK | Details > >
Send this error via Internet Copy to Clipboard [] Patient |JUHES‘ Happy ‘ ©=f Patient
Exclude No Reason O
Print Screen Close

Resolved an issue with how the Date Details were display in Linked Appointments

The Linked Appointment Details dialog has been updated to use text formatting consistent with the rest of
the application. This resolved Linked Appointment Details - Date Details overlap.

Linked Appointment Details
Office ZED-8596

You have selected a linked appointment type for this patient ~Name DOB  13/11/2002
appointment. Please enter the following information to Address

complete the linked appointment.

Original Appointment Details Linked Appointment Details Health Provider Availability

Date \Wednesday, 6 September 2023 IDate Wednesday, 6 September 20233t:| Wednesday, 6 Seplemberﬁ-l

Resolved issue with Patient Type details display in the Appointment and Attendance Details dialogs
The Patient Type in Appointment Details and Attendance Details screens no longer overlap the screen.

Appointment Details

Office ZED-8598

Date: Wednesday, 6 September 2023 Createdby PD G i I

" vP0 Simkins, Talia
Doctor GRACE HERMAN on 06/03/23at 12:08 o cag Pull File Yes DOB  24/10/1982
Resource Fistin 31/01/2023  Lastin 16/08/2023 | Type Patient Type ABQ
Start Time Clinic |Branch 1 ~|  Contact Details F

Duration

Status [ = Phone (H) 01000000 Work (W) 020000000
Mobile 0410 654815

An Assist Fee can no longer be used with non Assist able item

Office ZED-8657 When setting a billing item as an assisted item that is not an assistable item, the Assisting Billing Options
screen is no longer displayed.

Resolved an issue with the Service date and Billing date range in the Assistant Service Report.

Fixed the date picker button for “To date” on the Assistant Service Report so that the date selected is
displayed in the To field and not the From field.

Office ZED-8658
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Fixed the layout of the reprint token message box.
Removed an incorrect line in the message displayed when reprinting an eScript token.
Confirm x
Office ZED-8659 Printed token will not be valid if the presaiption has aready been
filled. If the patient requires a reprint of a repeatissued by a
pharmacy, the pharmacy that issued the repeat token will be able
to
reprint a token for them. Would you ke to confinue?
Reprint Token
Office will still run if the cancel button is clicked on the Login screen.
Office ZED-8772 | Fixed issue where Patients.exe would crash when Office was closed without logging in first (i.e. opens
Zedmed Office, then closes the login prompt to exit, without logging in).
Selecting F4 twice will once again bring up the last patient searched.
Office ZED-8777 | Fixed issue where if a patient is associated with more than one branch selecting F4 twice (or clicking on Last
button) did not open the last patient.
Staff Username truncates to 10 characters automatically
Office ZED-7492 | The "Edit Staff Member" dialog (Staff tab in the Securiy module) now prevents users from entering
usernames greater than 10 characters in length.
Added an Ethnicity field to Zedmed Clinical
Capturing or viewing a patient's ethnicity details has been added to the Family, Social & Past History
information in Clinical.
rF'atient - Holloway, Mr Knut (He/Him)
i i Family, Social & Past Hist i
Clinical ZED-8483 Patle?nt Details MNOK and Emergency Contact amily, »0<ia ast Mistory  Smoking  Alcohol  Other Clinicians
Miscellaneous
Oecupation bt
Sexuality Unknown = Ethnicity | ., British, neg British; NORTH-WEST EURDPEAN &
v
Family History
[ &
o Resolved Ul Issues in Clinical Reports
Clinical ZED-8544 Fixed some minor issues with font sizes and labels being cut off in the Clinical reports, including Font Types
or Font Size and Labels being cut off.
. Updated the Intramail Ul in Clinical
Clinical | ZED-8552 . . . - . .
Clinical intramail buttons and icons have been updated on main dialog to match those in Office.
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Fixed the Results Inbox Error: Unexpected end of command-line 2, column 1
Results Inbox has been fixed to prevent an error when retrieving results for all doctors on clinics with a large
number of doctors configured.
Clinical |ZED-8561 ||oroccurred x
e Unexpected end of command - line 2, column 1.
oete > |
[ Send this error via Internet Copy to Clipboard [
Enabled a configuration to limit attachments tab file size in clinical
Clinical ZED8574 | Added a maximum value in MB's for uploading of files to tabs in the summary views and set the default. This
can be found in the Global Options > General tab.
Turned on Icon captions by default in Zedmed Clinical
Encounter icon captions are now turned on by default for users logging into Clinical for the first time.
Clinical ZED-8595 Current Encounter - Duration: 00:00:02
QP s (o]0 OE —
d e & & O A B & & E
Problems Drugs Observations Referrals Immunisations Allergies umable Diagrams Templates Add Problem Del Problem CDM  Calculators
Resolved a formatting Issue When Copying Clinical Notes to Letter Writer
Clinical ZED-8630 | Added a new Paste Plain Text option to the Letter Writer to allow formatted text such as encounter notes to
be copied and pasted into a letter without formatting.
Introduced a Filter Feature for Merge Fields in Letter Writer
The Clinical Letter Writer now provides a filter function in the data toolbar, allowing for a quick look-up of a
field in the list of available merge fields.
Clinical | ZED-8633
i Filter =
[ Data Toobar
& Chinical Detais
# Treating Doctor
Resolved an access violation in module 'crs_client.exe' when closing Patients in Clinical.
Clinical ZED-8687 | Fixed an issue where an AV error was displayed in some cases after closing a patient file in Clinical where My
Health Record is enabled.
Resolved an issue with My Health Record auto-upload displaying errors at a test site
Clinical ZED-8739 | The error occurred for patients with a hidden record and displayed a warning that has been fixed.
The Write referral button in HealthShare will now only be an option in Referrals.
Clinical |ZED-8778 |Removed the"Write Referral" button from HealthShare address book search when opening the search
screen from the main toolbar in Clinical.
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Removed obsolete Zedmed files and exe from the Installer/Upgrader

Upgrader | ZED-8614 X L .
The Zedmed Upgrader has been enhanced to remove obsolete files from client installations.

Zedmed v36.1.1

PDF viewer unable to view the document - Blank Document
Clinical | ZED-8668 |Fixed anissue that may prevent the viewing of older PDF files, especially those produced by scanning
documents

Zedmed v36.1.0

Zedmed v36.1.0 is a major release that introduces a modern theme, integration with accounting software including Xero and MYOB,
HealthLink SmartForm enhancements and pronoun and gender updates.

Shortcuts to specific sections:

e Zedmedv36.8.1

e Zedmedv36.8.0

e Zedmedv36.7.0

e Zedmed v36.6

e Zedmed v36.5

e New Modern theme

e Surgical Partners integration

e Zedmed v36.1.0 Updates (part of the v36.0.0 release)
e Zedmed v36.0.0 HealthLink SmartForms enhancements
e Zedmed v36.0.0 Office & Clinical enhancements

e Zedmed v36.0.0 Office & Clinical updates

New Modern theme

No menus or layouts have changed, but you now have the option to use the new Modern theme or the existing Classic theme.

For the most up-to-date documentation version, visit https://help.zedmed.com.au/help
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File Encounter Results Reference Library Reports Tools Utilities Help

= R X ()

\
Open Patient ~ OpenFamily  Close Patient Waiting room | Results inbox v Address book Travel Batch letter To do list

Holloway, Andrea .

Holloway, Andrea JICurrent Encounter - Duration: 00:00:41

& e U S

Problems Drugs Observations Referrals Immunisations Consumable Diagrams Templates

(@) tnsetinesprasem |

Address: 5 Kingsley Gr,
BENOWA 4217
DOB: 26/12/1943
Age: 79 years
Medicare No: 49503503111
File No: 456
Hosp UR Ne:
MHR Status: Consent to Upload
Referrer: Dr Support Zedmed

G) RFE: | [ Use Coded RFEs |Management Plan

Summary Views

| Problems | Referrals | Resuits | Immunisations | Allergies | Images/ECG | Pregnancies |

Documents | Attachments | Measurements | Medications | Incoming Decuments |

History View

7 Include MHR Sort: |Medication Text « Oldest Encounter: 20/05/2021
L S h Billi s
2 1[2]13] V| 3| 8||Q Hey | Hia

Prescribed >

Current Medications L izard| Visible: | Last 10 Consultations v Include MHR

Regular Use
Paracetamol 500mg Coated Tablet 500mg [20] - TAKE 2 TID
Paracetamol 500mg Coated Tablet 500mg [50] - TAKE 2 TID AS DIRECTED

Intramail
12/08/2022 (Fri) 10:00am with Dr Phillip Davis at MED, for 4h 23m 10s
parental anxiety

PRN 15/07/2022 (Fri) 10:54am with Dr Phillip Davis at MED, for 16m 08s
Short Term Headaches
Non-current Medications 13/07/2022 (Wed) 11:21am with Dr Phillip Davis at MED, for 17m 45s
Stomach ache
20/05/2021 (Thu) 5:09pm with Dr Phillip Davis at MED, for 0m 20s
et Vicw Allergy: Crunchy peanut butter
Al\erg\es:lcm"d"y peanut butter @
Warnings: | Py
Recalls: | @

e The first time you open Office and Clinical after the upgrade, you will be prompted to choose a theme.
e You can have matching or different themes in Office and Clinical.
e You can swap themes at any time if you change your mind.

The first time opening Office - select Modern or Classic. To change -Themes > Modern or Classic.

1
2]
Appointment  Search  View Refresh WaitingReom Patient Bill Encounters RefDrs Close Extra

Management Reports Taols Practice Setup WP Setup  Utiities

-IHatcher, Danni - Reception Management ts
27 Jun (Tue) 28 Jun (Wed) 29 Jun Thu) e
14M o 0 0|
© Modemn ‘ Waiting Room
Appointments
4 Au o) 0 ol

Appointment Search View Refresh WaitingRoom Patient Bill Encounters RefDrs Close Extra

2 & = . o) Qs
” / - - - +} J
ey tn Branch 1 Hatcher, Danni s L
27 Jun (Tue) 28 Jun (Wed) 29 Jun Thu)|
e o] [ 0
O Classic .
7Au o g o Message of the Day
‘Welcome to Serenity S
Zedmed S/W Support
Tel: 1300 933 000
Fax: 03 9284 3399
= T After Hours: 0408 002 964
4 Month 4 Week 4 Day Day ﬁ Week b Month b 3Months B 6 Months b 3 M v

Today
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The first time opening Clinical - select Modern or Classic.

O Modemn ‘

Smith, Henry [E

Fie Encounter Resolts Relerence Lbrary Reports Tocks Utiibes Help

Semith, Henry

Address: 12 varle st L

DUEBO 2830
DOB: 17/06/1040 Home:
: Work:
Medicars Mo 20513250241 Mobile:
File No: C22 Oceupation:
Hosp UR No:

MHR Status: Consent to Upload

Tl e () et e

@

e

Undefined Probiem

To change - Tools > My Options > Modern or Classic.

ile Encounter Results Reference Library Reports]

Utilities Help

pioprons

General | Drug Options | Document Handling | Fundtion Selections | My Health Record |

Defauts
Show Pathology Details Form
p
CRS Close Prompt
Show Audit Records
Froblem Quick Select
Patient Clase Prompt
Show Graph Values
Button Captions
Show Encaunter Button Captions

Problem Search Type

My Most Recent

RROO000RO

o) (3

VI Show s C

Ocassic [y

File Encounter Resuti Reference Lbiary Rapats Tock Utilties Help
-

()

e

atient | WaitingRoom | Resulls Inbox

§iy
-

Address: 12 wattle St
DUBBO 2630

DOB: 17/06/1940 Home:
Age: 83 years Work:
Medicare No: 23513360241 Mobile:
File No: C82 Occupation:
Hosp UR No:

MHR Status: Consent o Upload

ST

Current Encounter - Duration: 00:03:09

L

Problems  Drugs Observations. Refemaly

[V]ACR Prompt

Show Prablem Criticality

[ Defauit IPC scaren to shaw Probiems / Symptoms Oniy
[ Default to viewing enhanced Resuls iew (PDF or RTR

S

Medications >.. wledication Text

Meaurements Summary View - Sort By [Type v
Default Waiting Room Order By [Attendance Time
Default Summany View Tab [Froblems v

Defoult Printer Settings [Local v

Show [Last 10 Consuttations | in History View

Default Template

Predictive Search (ICPC and Co v

i, WP

Document Tempiate [Re Letersomaors

o=

Undenned Problem

[cmwmm“

® Classic O Modern

)

e e[
T

Surgical Partners integration

Images (Zoom To)

Show et Dislag i Patent
Wrregnant

Mibreast reecing

[etite Sports Person

[age Greater Than | v | vears
¥ Has Recalls D Overcve

[¥Has Pending / Initial Results

- ,QM

Pathology | Gribbie [
Radiology | RADPLUS Radiology
Use Clinical Billing Wizard

o) Ono ® site Detoutt
[IBilling Wizard: Inform if No Matching Attendance of Encounter Cic
Use Chronic Disease Madule
Oves ONo ® Site Defoult
Consultation Timer Alert

[use Consutation Alert [ geep at End Time

7 Heip

o oK X cancel |

Surgical Partners is a financial management platform that integrates Zedmed with accounting products including Xero and MYOB.

This allows you to use the financial information in Zedmed for a range of financial applications from debtors' management to banking
and payroll. This functionality is enabled by registering with Surgical Partners who will configure Zedmed to send the required
financial data to your accounting software each night.

To learn more, visit https://surgicalpartners.com.au.

Zedmed v36.1.0 Updates (part of the v36.0.0 release)

Clinical

ZED-8328

Implemented a new PDF tool to view results and scanned documents in Clinical
Removed the requirement for Adobe Reader from Zedmed. PDFs can now be viewed (both when embedded
in aresult and when attached from a scan) without any external PDF viewer installed.

Office

ZED-8252

Access Violation error resolved when deleting an Appointment Type
Fixed an error that occurred when attempting to delete an appointment type from Office

Office

ZED-8360

Corrected the Message/Buttons displayed when a Tyro Easyclaim has been canceled.
The message displayed when a user canceled a Tyro Easyclaim has been resolved and the form now allows
another attempt.

Office

ZED-8423

Deleted prescriptions are no longer displayed on HealthLink Forms.
Deleted prescriptions were still showing up as selectable options in the HealthLink SmartForm.
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The Encounter Timer no longer disappears when resuming an encounter.

Clinical | ZED-8452 |Fixed anissue where the Clinical Encounter timer would no longer be displayed after resuming an existing
encounter.
Updated the Appointment and Full day icons for the Modern Theme.

Office | ZED-8481 |Updated theicons displayed on the Appointment Grid for Appointment and Full Day menu bar options so

they are no longer similar to Zoom In and Zoom Out icons.

Zedmed v36.0.0 HealthLink SmartForms enhancements

For new users, please follow the Zedmed SmartForms installation guide.

For existing users, please follow the manual upgrade guide.

Improved the names used for attachments in SmartForms
Each HL7 results file can include several sections, and Clinical Results Inbox displays them as follows:

1. Result View tab.

2. Enhanced View tab - HL7 file includes only 1 additional part.
3. Enhanced View #N - HL7 file includes N additional parts.

4. 2 and 3 are not always present, depends on HL7.

Results in HL7 files added as attachments to a SmartForm will be named as follows:

1. <HL7 FResult Name> (Result View) tab.
2. <HL7 FResult Name> (Enhanced View) tab - HL7 file includes only 1 additional part.
3. <HL7 FResult Name> (Enhanced View #N) - HL7 file includes N additional parts.

Clinical |ZED-8267 2 and 3 are not always present - depends on the HL7.
Requested Information gk Diagnostic Reports / Patient Documents [ Browse for Patient Document ” Browse for Local File
R Aftach file from EMR supports: gif, htmi, [peg, doc, docx, pdf, b, fif, 1iff
Attach file from Computer supponts files that end in types: doc, docx, gif, him, himl, jpeg. Jpa. pdf, rif, tif, tff, ta
Caution: larger attachments may take significant time lo preview
Attachments | Reports — [ )
B vt walechud LU Date ot Fammmans Type gz
ik e e [ | 13/07/2023 = Attachment et 1KB E
A T T120772023 Colorectal Cancer Structured ' "Tvea @
Medications, Allergies, Pathology Report (Enhanced View
Alerts A A,
2 f ecified [ | 12/07/2023 = Colorectal Cancer Structured html B
Pathology Report (Enhanced View
#2)
. ) : (] | 12/07/2023  Colorectal Cancer Structured pdi B
Medical, Social and Family Pathology Report (Result View)
SRRV ""CJ | 1200772023 | Documants RTF fla ' T ae | @)
[ | 120772023 | ImagesECG ot 1KB ®
Zedmed's Healthlink SmartForms integration is now upgradeable
Clinical |ZED-8292 | The Healthlink SmartForms service installer has been updated from an MSl into an exe file (as used by other
parts of the Zedmed software) so the software is now upgradeable.
Healthlink SmartForm will display 1 attachment for HL7 files with 2 records
- The functionality of Zedmed's HealthLink SmartForms integration has been improved. HL7 results that
Clinical | ZED-8332

include PIT segments in addition to FT segments will be included as one attachment (as it is done in Clinical,
Results).
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The 'HealthLink Create Referral' button can be removed from the Encounter toolbar
Doctors can now remove the 'HealthLink Create Referral' button from the encounter toolbar. This is done in
Clinical > My Options > Function Selections tab > Show the HealthLink button.

[Current Encounter - Duration: 00:05:49

FooYWRLOIABRFEE

General Drug Options Document Handling Function Selections  hy Health Record &

My Options

41 5how the Problems button

[ show the Preseriptions button
[ Show the Observations button
[£] show the Referrals button

[ show the Immunisations button
B4 show the Allergies buttan

[ show the Consumable button
[ show the Diagrams button
Show the Templates button

[ show the Add Problem button
[] Show the Delete Problem button

[ Show the Pregnancy button

[ Show the Chranic Disease Module button <] @& Indude MHR

[ show the Clinical Calculators button
B4 show the Capture button

[~ show the Histories button

Clinical | ZED-8379

[ show the Spelicheck button
[] show the Backdate button

[DSMW 1he Create New HealthLink Refe ral button ]

Resolved a scenario where a staff name could appear as the provider in a SmartForm

Clinical | ZED-8387 Resolved an issue that caused the provider details ( Referred By name) in a HealthLink SmartForm to be
inica -

populated with a staff member's details instead of the provider's details, when the staff member's ID was the

same as the doctor's code.

Zedmed v36.0.0 Office & Clinical enhancements
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New Pathology & Radiology referral templates added to the Clinical Addressbook for:

e Australian Clinical Labs Comprehensive Carrier Screen Request = PathologyClinicalLabsCCS
e Queensland Ultrasound for Women = RadiologyQUFW

e Sydney Ultrasound for Women = RadiologySydneyUIltrasoundForWomen

e Vision Radiology = RadiologyVisionCardiac

Clinical |ZED-7979

Laboratory Details
|:| Use As Preferred Laboratory
LT DT I FadiologytdelbourneRad Clinic

Lab Communications

~ | DL Command Line |

RadiologySydneyUltrasoundFarWomen a .

RadiologyToowombaDiagnosticimaging DL Directory D'
RadiologyUniRad UL Directol [=)
RadiologyUniRadiology 'T |
RadiologyUniRadiolagy2
RadiologyVictorianMedicallmagin,

Vertical Offset{mm)

Update Details frof ? Help W oK XK concen

RadiologyWesternimagingForWomen ¥

Pronoun field added to Zedmed Office & Clinical
Added support for specifying preferred pronouns to Zedmed. Pronouns can be set in either the Office or
Clinical Patient Details forms and are displayed in the following locations.

e The selected pronouns will appear when chosen in the patient record Pronouns drop-down.
e Enabled at practice and branch level.
e Additional pronouns can be added in Practice Setup > Drop-down List Management> Pronouns.

| #d Drop-Down List Management [} x
Appointment Cancellation Reasons | Desaription Fladive [Ja [Omep [Jer3 [Jere
Checklists RS

She/Her
Instrument 3
They/ Them
Procedure Type
Product Category
Ihnnoun:
Frasthesis
Stock Movement Reason
Add Value | |Delete Value | Close

Pronouns display:

e The header of patient details summary in Clinical.
e Title of patient details in Clinical.

e
Waiting room

Jones, Mr Happy (They/Them) u
Jones, Mr Happy t'l'rn-y_fThum}

e Patient record tabin Clinical.
e Title of patient details in Office.

h e e ]
AccEnquiry Attend”  ©N  Letters Clinical information  Print  Quote Receipt Waiting Room  Appointments  Extras
Personal Practice
T Family Name iJone: | Filew# 22
Further Details
T [ -y
OffICE/ Recalls Given Name |.Hapmr | Initial Hasp. UR No L
.. ZED-1674 Hotepad Preferred Name | | Former Usual Branch | Branch 1 (22)
Clinical - -
eHealth Title !Ml Sexat Bith (M First In
Messages Pronouns !Thc;.-"l'hcln - Type |

Pronouns & Sex at Birth
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¥4 Jones, Happy
AccEnquiry Attend  Bill  Letters Clinical Information  Print  Quote Receipt Waiting Room  Appointments  Extras
Personal Practice
Patient Details P
Family Name |Jone; | Filew |22 Pull File (7]
Eurther Details
i Given Name [Happy | initial Hasp. UR No | | Clinical Warnings
Motepad Preferred Name | | Former Usual Branch | Branch 1 (22) ~
P4 eteaith Title |Mr [Se! at Birth M a First In Last In
Messages I g “— ﬂ Type [~] Status | Current [»]
A
Date of Eirth ge 58 Family
[ | [She/Her
= | Home “| | They/Them * lones, Happy (22) o
Family Links
Suburb |ISABELLA PLAINS | [zg0s
Preferred Contact Payers
Method Branch Default (not set) w _ -
S [Mobite ][ ] Fund  No fund set for this patient
Do Not Send SMS [ Default Appointment SMS [:] = o Claims
Usuwal Dr | None ~ 2
Referrals
Medicare [2050 86204 1 2 | Exp N — ;]
Veteran Bp |
| | P | Add Details
Health Care | | Exp |
Other Contacts
Safety Net
NOK Name |:| Relationship I
Pen. Stat. ~ PES Co-payment T
= == & |Home v |
ATSI Mot Recorded -
Emerg. Contact Name l
Ethnicity -
]| |« |
Alerts
**Transterred to different card, Old card quoted,**
Delete | | Pint | PatientVerification | | Find [ cese || cance

Changed "Gender" to "Sex at Birth"

Changed the "Gender" field to read "Sex at Birth" in Office, Clinical and the Patient Merge utility.

12 Months - in 5A as Dose 3 OR ATSI only as Dose 4
HenB

Office ZED-8194
See the screenshot above.
Ethnicity is available in the Patient Merge utility
Office ZED-8202 | Ethnicity is now available in the Patient Merge utility when merging duplicate records. It is displayed when
Advanced is selected.
Changed the default dose for Prevenar 13 Childhood immunization
Updated the dose from 4 to 3 for the 12-month Pneumococcal (13vPCV) Childhood Scheduled Immunisation.
Childhood Immunisstion Schedule x
B R R R s AR BARIC
[ Brand/Vaccine Date Batch Comment Dose Doctor add.,
Clinical |ZED-8215 |~
1 Madify...
; Deiete..,
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Added the Service date to the Claims screen and Claims Report

Claims Status Ul and report now show the date of the service against each item in the invoice.

P4 Claim Status

Refresh Default View Expand All Collapse All Void Rejected Invoices

Claims  payments

Office ZED-8326 From [11/07/2023 [@~| @  AllSubmitted ClaimTypes ~| Branch <All>

To 18/07/2023 [@~ | O Mot Submitted

»| Dodor <All>

s | Claim D

Status  <AlL> w

eatient |All Find Patient Clear
O Irw.fServi(e,f.\\s;ls;or Status Patient CQutstanding Paid Doctor Claim 1D Medicare
= Inv 103015 T80T 2023 WITH ME...  Simkins, Talia 5331.50 50.00 Augustus Eason 211307 211307
“116 4/07/2023 Unpaid $110.50 50.00
116 11/07/2023 Unpaid §110.50 50.00
116 18/07/2023 Unpaid 5110.50 50.00

Replaced the PDF viewer for the "View Claim" button in Account Enquiry

Updated the application used to view PDFs in Office for Claims. Viewing a claim from the account enquiry
screen is now significantly faster.

& Account Enquiry

Patient  Simkins, Talia

Payer Simkins, Talia Bas Recalculate
Cumr 331.50 30+ 0.00 60+ 0.00 .00
. Transacton
Office ZED-8370
Invoice® Date Patient HIC  CLM# B Dr Value Qutstanding
>-I 103015 18/07/2023 SIMKINS, TALIA P4 PDF Viewer

| save As (i print (=) Print (with printer selection) | 4 FitWidth | FitPage /® ZoomIn /= Zgom Out

Patient Claim Consent and Declaration

Location ID: SAP02482 Reference: 211307

Zedmed v36.0.0 Office & Clinicalupdates

Important update.
Clinical ZED-8286 Reduced the flicker on the Results Inbox display list
Results Inbox module has been reworked to prevent flickering as users action results.
Resolved an error that occurred when merging patients with the same SMS message
Office ZED-5462

When merging patients that reference the same SMS message, Zedmed Patient Merger will now only move one copy the message to the merged record. Previously it would
report an error and abort the merge process.
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The Last (F4) Button now works in Appointments
While searching for patients on the Appointments Ul, selecting the Last F4 button now selects the last opened patient in the appointment search dialog.
Tue Hatcher, Danni
8AM
QAH
T[W
45 45[ 17 Jones, Marrianna|
Office ZED-5494 10 1[ fl
15| J 15 15|
2 2 Search i
- “?l arch for
TR 0 Patient Jones, Happy
5 = =
= [Date Time stion Doctor Resource Branch Status  Notes
5 TueTBUT/ZZ SICGOAN WD MED Adwe
12
™ |
lem
[Ceato || mintust | petete | Refresn
Office ZED-7111 The Delete button in Staff Maintenance>Apps Access no longer causes an Access Violation
The Delete button on the staff permissions maintenance dialog, App Access tab, will now remain disabled until a selection has been made to prevent an error.
Resoved Error Data too large for variable [[ITEM_CODE]. Max len = [8], actual len = [9] when running AMA Fee Load
The Load MBS/AMA Item By Criteria option now works when the Load from AMA file checkbox is selected and an AMA load fee file is used. AMA fees will now be loaded as
long as the corresponding MBS item already exists, a report is displayed at the end of the import listing the items that could not be imported.
Load MBS/AMA ltem x
®) Load MBES/AMA Item By Criteria
xisting MBS/AMA n
Office ZED-7982
Loaded Items
Item Mumber Commence Date
|
Full =
Description
w
Number of ltems Loaded : [l Continue Without Short Description
- Load from AMA file I
Office ZED-7983 Resolved Error - Param [NEWSTARTDATE] type changed from [ftSQLTimeStamp] to [ftDateTime] running AMA Update Fees
The Update Existing MBS/AMA Items with the Load from AMA file option selected will now run without error and enable the update AMA items.
Office ZED-8233 Statistics report - Referral Doctor criteria now correctly lists all address book entries (not just referral doctors)
Referral Doctor criteria in the Statistics Report will now only list Referral Doctor contacts who are set as Available.
Office ZED-8247 Resolved Error "Zedmed Office was unable to load the OLE object file" when you Select or Preview an archived letter
Fixed the issue with an error being displayed when selecting or previewing patient letters that have been archived.
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Clinical ZED-8248 Resoved Error 'Type ID Mismatch' when importing CDA letters
When importing HL7 messages that contain XML files with a namespace prefix, Zedmed Clinical will report a more accurate error instead of returning "Type ID mismatch".
Office ZED-8362 Rlesolved an Intramail error in Sent Ij(emf ) ) o ) ) ) )
Fixed an error that occurred when viewing sent items in office intramail when the To: or CC: fields contain a combined total of more than 1000 characters.
A double booking Patient's name will no longer change when editing the appointment.
Office ZED-8367 Modifying an appointment by selecting it from the appointment selector (appointment 'Details' context menu option), no longer displays a different patient in the
appointment selector at the end of the process.
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